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Preface

Notice

The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.

©May 2007

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. pat-
ents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of
this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home
or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineer-
ing or disassembly is prohibited.

Intel, Celeron, and Intel Core are trademarks/registered trademarks of Intel Corporation.
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FCC Statement

(Federal Communications Commission)

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

» Re orient or relocate the receiving antenna.

* Increase the separation between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
» Consult the service representative or an experienced radio/TV technician for help.

\ A/
ZAS
Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropriate antennas will be installed. Note
that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate in
conjunction with any other antenna or transmitter.
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IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1.

2.

Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet
basement or near a swimming pool.

Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There
may be a remote risk of electrical shock from lightning.

Do not use the telephone to report a gas leak in the vicinity of the leak.

Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may
explode. Check with local codes for possible special disposal instructions.

This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC
Output of 19V, 3.42A (65 Watts) minimum AC/DC Adapter.

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER,
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1.

Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

Do not expose the computer Do not place it on an unstable | Do not place anything heavy
to any shock or vibration. surface. on the computer.

Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose it to excessive Do not leave it in a place Don’t use or store the com- Do not place the computer on
heat or direct sunlight. where foreign matter or mois- | puter in a humid environment. | any surface that will block the

ture may affect the system. Vents/Fan Intakes.

@
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Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other
strong magnetic fields. These can hinder proper performance and damage your data.

Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

Do not turn off the power
until you properly shut down
all programs.

Do not turn off any peripheral
devices when the computer is
on.

Perform routine maintenance
on your computer.

Do not disassemble the com-
puter by yourself.

Take care when using peripheral devices.

Use only approved brands of
peripherals.

Unplug the power cord before
attaching peripheral devices.
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Power Safety
The computer has specific power requirements:

;Il’; « Only use a power adapter approved for use with this computer.
Power Safety  Your AC/DC adapter may be designed for international travel but it still requires a steady,
Warning uninterrupted power supply. If you are unsure of your local power specifications, consult
Before you undertake your service representative or !ocal power company. .
any upgrade proce- » The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong
dures, make sure that is an important safety feature; do not defeat its purpose. If you do not have access to a
you have turned off the compatible outlet, have a qualified electrician install one.
power, and discon- » When you want to unplug the power cord, be sure to disconnect it by the plug head, not by
nected all peripherals its wire.
f‘erl‘s ﬁab'esl_ ('”Cluld'”_g « Make sure the socket and any extension cord(s) you use can support the total current load
A i) L€ 15 of all the connected devices.
advisable to also re- X C e s
WA © Before cleaning the computer, make sure it is disconnected from any external power sup-
order to prevent acci- plies (i.e. AC/DC adapter or car adapter).

dentally turning the
machine on.

Do not plug in the power Do not use the power cord if | Do not place heavy objects
cord if you are wet. it is broken. on the power cord.
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Battery Precautions

Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.

Do not remove any batteries from the computer while it is powered on.

Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even
if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly
result in fire.

Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.

Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-
ified service personnel.

Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries
may explode or leak if exposed to fire, or improperly handled or discarded.

Keep the battery away from metal appliances.

Affix tape to the battery contacts before disposing of the battery.

Do not touch the battery contacts with your hands or metal objects.

\ A/
A&
Battery Disposal & Caution
The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,

under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.

\1
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Cleaning

Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing

Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

*  When the power cord or AC/DC adapter is damaged or frayed.

 If the computer has been exposed to rain or other liquids.

 If the computer does not work normally when you follow the operating instructions.

« If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
 If there is an unusual odor, heat or smoke coming from your computer.

S
&
Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.

VI
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

Check that the battery pack and any spares are fully charged.

Power off the computer and peripherals.

Close the display panel and make sure it's latched.

Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.

The AC/DC adapter uses voltages from 100 to 240 volts so you won't need a second voltage adapter. However,
check with your travel agent to see if you need any socket adapters.

Put the notebook in its carrying bag and secure it with the bag’s straps.

If you're taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters
and/or cables.

8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-
ware and software. Make sure your documents are prepared.

SN
ALK

Power Off Before Traveling

agprwNPE

N o

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep itdry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

» Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

» Your knees should be slightly higher than your hips. Place your feet flat on the floor or on
a footrest if necessary.

» Use a chair with a back and adjust it to support your lower back comfortably.

 Sit straight so that your knees, hips and elbows form approximately 90-degree angles
when you are working.

» Take periodic breaks if you are using the computer for long periods of time.

Remember to:

 Alter your posture frequently.

 Stretch and exercise your body several times a day.

» Take periodic breaks when you work at the computer for long periods of time. Frequent
and short breaks are better than fewer and longer breaks.

Xl
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

« Position the display to avoid glare or reflections from overhead lighting or outside sources of light.

» Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
« Position the display directly in front of you at a comfortable viewing distance.

« Adjust the display-viewing angle to find the best position.

LCD Screen Care

To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

» Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.

» Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
» Rotate desktop background images every few days.

e Turn the monitor off when the system is not in use.

Xl
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Quick Start Guide

Chapter 1. Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

e Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk,
optical device, 7-in-1 card reader, ExpressCard/34/54), TouchPad & Mouse, Function/Hot
Keys, Quick Buttons, Audio & Printer.

e Chapter 3  The computer’s power saving options.

e Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the
computer’s subsystems.

e Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).

» Chapter 6 Instructions for upgrading your computer.

e Chapter 7 A quick guide to the computer’s Wireless LAN, Bluetooth and PC Camera modules (some of
which may be optional depending on your purchase configuration).

e Chapter 8 A troubleshooting guide.

» Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external
devices.

» Appendix B Information on the SIS Video driver controls.

» Appendix C he computer’s specification.

» Appendix D Information on the Windows XP OS.

. |
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Quick Start Guide

Advanced Users

If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the User’s Manual. You may also find the notes marked with a /Z of interest to you.

Beginners and Not-So-Advanced Users

If you are new to computers (or do not have an advanced knowledge of them) then
4 the information contained in this Quick Start Guide should be enough to get you up
Notes and running. Eventually you should try to look through all the documentation (more
Check the light colored detailed descriptions of the functions, setup and system controls are covered in the
boxes with the mark . remainder of the User’s Manual), but do not worry if you do not understand every-
above to find detailed in- = thing the first time. Keep this manual nearby and refer to it to learn as you go. You
tors foatire. e <™ | may find it useful to refer to the notes marked with a #as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface

(Ports & Jacks)” on page A - 1.

Warning Boxes

No matter what your level please pay careful attention to the warning and safety information indicated by the
2 symbol. Also please note the safety and handling instructions as indicated in the Preface.

1-2 Overview
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Not Included

Operating Systems (e.g. Windows Vista/Windows XP) and applications (e.g. word processing, spreadsheet and
database programs) have their own manuals, so please consult the appropriate manuals.

4

Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed in. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed.

If your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.

. |
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System Software

Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the following operating systems are sup-

ported.

Operating System & Version Supported

Note

*Windows XP Home or Professional Editions

In order to run Windows XP without limitations or decreased
performance, your computer requires a minimum 512MB of
system memory (RAM)

Windows Vista (32-bit) Home Basic Edition

In order to run Windows Vista without limitations or
decreased performance, your computer requires a minimum
1GB of system memory (RAM)

Table 1 - 1 - Model Differences

*Note: For information on the Windows XP OS (specifically power, video and driver information) see “Win-

dows XP Information” on page D - 1.

1 -4 Overview




System Startup

Quick Start Guide
Remove all packing materials.

Place the computer on a stable surface.

Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.

Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an

outlet, and connect the AC power cord to the AC/DC adapter.

Raise the lid/LCD to a comfortable viewing angle, and press the power button to turn the computer “on”.

Adjust the LCD panel to a comfortable viewing angle.

7. The LED indicators show the power and battery status of the computer.

PobhPE

owu

4

Shutdown

Note that you should always shut your computer down by choosing
the Shut Down command from the Lock Button Menu in Win-
dows Vista. This will help prevent hard disk or system problems.

Figure 1 - 1 - AC/DC Adapter In

System Startup 1-5



Quick Start Guide

System Map: LCD Panel Open

Figure 1 -2
LCD Panel Open

=

Built-In PC Camera

(Optional)

LCD

Speakers

Power Button

Hot Key Buttons

LED Status

Indicators

Keyboard

Touchpad &

Buttons

9. LED Power &
Communication
Indicators

10. Fingerprint Module
(Optional)

11. Built-In Microphone

ok wd

© N

1 -6 System Map: LCD Panel Open

Wireless Device
Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited. Make sure the mod-
ule(s) are OFF if you are using the
computer aboard aircraft.

Use the key combinations to toggle
power to the 3.5G/WLAN/Bluetooth
modules, and check the LED indicator
icon to see if the modules are powered
on or not (see




Quick Start Guide

LED Indicators

- . Icon Color Description
The two sets of LED indicators (LED Status Indica- .
tors and LED Power & Communication Indicators) Orange DC Power is Plugged In
on the computer display helpful information about the I Green The Computer is On
current status of the computer. Db

Blinking Green The Computer is in Sleep

Mode
Icon Color Description Orange The Battery is Charging
Green Silent Mode Activated (see over) m Green The Battery is Fully Charged
% Off Normal Mode Activated (see over) Blinking Oranae The Battery Has Reached
9 9 Critically Low Power Status
[-_-‘:’j Green Hard Disk Activity - -
The (optional) Wireless LAN
Green Module is Powered On
[E] Green Number Lock Activated @
Orange The (optional) Bluetooth
Green Caps Lock Activated Module is Powered On
Green Scroll Lock Activated (to activate % Green The (optional) 3'd56 Module is
ﬁl press Fn & Scr LK) Powered On
Table 1 - 2 - LED Status Indicators Table 1 - 3 - LED Power & Communication Indicators

System Map: LCD Panel Open 1-7



Quick Start Guide

Hot Key Buttons & Keyboard

These buttons give instant access to the default Inter-
net browser and e-mail program, and allow you to tog-
gle the Silent Mode on/off with one quick button
press.

Table 1 - 4 - Hot Key Buttons

Hot Key Function

B
W
M

*When enabled, Silent Mode will reduce fan noise
and save power consumption. Note this may reduce
computer performance.

Activate the Default E-Mail Browser

Activate the Default Internet Program

Toggle *Silent Mode (for power saving)

The keyboard has a numerical keypad for easy numer-
ic data input, and features Function Keys to allow you
to change operational features instantly.

Activate the Number Lock feature by pressing the
Num LKk key at the top right of the keyboard. You may
check if Number Lock is enabled or not by looking at
the LED status indicators.

4

Other Keyboards

If your keyboard is damaged or you just want to make
a change, you can use any standard USB keyboard.
The system will detect and enable it automatically.
However special functions/AP-Key buttons unique to
the system’s regular keyboard may not work.

1 - 8 Hot Key Buttons & Keyboard



Keyboard

Quick Start Guide

The keyboard has a numerical keypad for easy numeric data input, and features function keys to allow you to
change operational features instantly (see Figure 1 - 3). See Table 1 - 5, on page 1 - 10 for full function key

combination details.

= | Im |5 |5 Function Keys |80 & ™ | & l"‘ x kel n.ulm
i VAT TN & 7 s I P
E I NumLk &
PIay/Pause Key I 6 ] 7 J I ScrLk Keys,
s Q w E R T U4 P/ I ( E:
. R, | _— 3 SG Module
A s D F G I - Y 1‘_l'u a :ar- T 'POWGI’
Caps Look Numencal Ke)_/.pad_;__. ‘-|— Key |
Hon 4 X (o} v B 4 \Shin
* " | FnKey T“ T Bl

Figure 1 - 3 - Keyboard

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system

will detect and enable it automatically. However special functions/hot-keys unique to the system'’s regular keyboard may

not work.

Keyboard 1-9




Quick Start Guide

Function Keys
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down.

Fn Key Function Fn Key Function
Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F7 Display Toggle

Fn+ _ [j 3.5G Module Power Toggle Fn + F8 Decrease LCD Brightness
Fn+F1 TouchPad Toggle Fn+ F9 Increase LCD Brightness
Fn+F2 (Press a kl—;l;?) I;?Esga}ri)kdg?lit’;ﬁto turn on) Fn + F10 PC Camera Module Power Toggle
Fn +F3 Mute Toggle Fn +F11 Wireless LAN Module Power Toggle
Fn+F4 Sleep Toggle Fn + F12 Bluetooth Module Power Toggle
Fn +F5 Decrease Audio Volume Fn + NumLk Number Lock Toggle
Fn + F6 Increase Audio Volume Fn + ScrLk Scroll Lock Toggle

Table 1 - 5 - Function Keys

4

Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters. These special characters can only be produced by using
the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that NumLk is on.

1-10 Function Keys



Quick Start Guide

System Map: Front & Rear Views e
igure 1 -
Front & Rear Views

LCD Latches

LED Power &
Communication
Indicators

7-in-1 Card Reader
S/PDIF-Out Jack
Microphone-In Jack
Headphone-Out

/ Jack

7. Battery

N

o0k w

7-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:
MMC (MultiMedia Card) / SD (Secure Digital) / MS (Memory Stick) /

MS Pro (Memory Stick Pro) / MS Duo (requires PC adapter) /
Mini SD (requires PC adapter) / RS MMC (requires PC adapter)

System Map: Front & Rear Views 1 - 11




Quick Start Guide

System Map: Left & Right Views

Figure1-5
Left & Right Views
1. DC-In Jack
2. RJ-45 LAN Jack
3. External Monitor
Port
4. Vent/Fan Intake/
Outlet

o

3 *USB 2.0 Ports

6. Optical Device
Drive Bay (for CD/
DVD Device - see
page 2 - 3)

7. RJ-11 Phone Jack

8. Security Lock Slot

\ A/

Y/ \N

Overheating

To prevent your computer from overheating make sure nothing blocks the vent(s)/fan in-

take(s) while the computer is in use.

1-12 System Map: Left & Right Views



Disk Eject Warning

Don't try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don't try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.

Quick Start Guide

4

Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.

.|
System Map: Left & Right Views 1 - 13
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System Map: Bottom View

Figure 1 -6
Bottom View
1. Battery_ CPU
2. Hard Disk Bay
Cover The CPU is not a user serviceable
(3.5G Module part. Opening this compartment,
Location) or accessing the CPU in any way,
3. RAM & CPU Bay may violate your warranty.
Cover Overheating

To prevent your computer from
overheating make sure nothing
blocks the Vent/Fan Intake while
the computer is in use.

4

Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely

discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions.

1-14 System Map: Bottom View



Quick Start Guide
Windows Vista Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows Vista (and most other Windows versions) are
accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon 4, and then select Properties if you want to customize the appearance of the Start menu.

@) oeurogoms |

#1 Windows Update
<

‘ Open e Imternet

Explore o Emal

o
Search... u

Properties 7 Programs

= s, Documents
| Open All Users >

m‘ Explore All Users
T

B Control Panel

v
|=# Printers
L Taskbar and Start Menu

- "Tues

2.0 t0 g‘éle;_cigsgic'_\;/iéw

e Start Sea O -

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows Vista provides basic controls for many of the fea-
tures, however many new controls are added (or existing ones are enhanced) when you install the drivers listed
in Table 4 - 1, on page 4 - 3. To see all controls it may be necessary to toggle to Classic View on.

Windows Vista Start Menu & Control Panel 1 - 15



Quick Start Guide

Video Features

You can switch display devices, and configure display options, from the Display Settings control panel (in Per-
sonalization) in Windows Vista and/or the SiS VGA Control Center. For further information see “SIS Video
Driver Controls” on page B - 1.

To access Windows Vista Display Settings:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click Adjust screen resolution under the Appearance and Personalization menu (or double-click
Personalization > Display Settings).

3. Move the slider to the preferred setting in Resolution: 0 (Figure 1 -8 on page 1-17).

4. Click the arrow, and scroll to the preferred setting In Colors: Q(Figure 1-8onpagel-17).

5. Click Advanced Settings (button) 9 (Figure 1 -8 on page 1 - 17) to bring up the Advanced Settings tabs.

To access the SiS VGA Control Center:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).

2. Click SiS VGA Control Center @ (or click Appearance and Personalization > SiS VGA Control Center).

3. Click the top menu icons to bring up the appropriate control panel to adjust the settings.

4. You can also access SiS VGA Control Center by right-clicking the SIS Tray taskbar icon E and selecting
Control Center.

1-16 Video Features



Quick Start Guide

Control Center

; Acagter | morator | Troubleshont | Coloe mansgement |
Dreg the ions to match your monftods. | [dennify Moniters | salegiler Tyge

' 55 Mirage 3 Graphics.
Adsater Infarmation

(hip Type: SEATL series
DAC Type: Inserel

Adaoter String:  Mrsge 3
Bios Informabion: 3.67.1A4

Tuksl Avalable Graphics Memory:  192M8

Dedecated Wideo Memory: 1M
Sipulem Vider Memee y: oma
Shared System Memory: 4ME

Liat Al Modrs...

G/ » cometrmt +

frgiem 1t S
Pl B ol bl

1280 * 200 pinels., True Coler (37 b}, B0 Herlz -

Figure 1 - 8 - Display Settings & SiS VGA Control Center

Video Features 1 -17



Quick Start Guide

Power Options

The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 15) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to

create a new plan. Click Change Plan Settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Select a power plan

Poower plans cam belp you masmize your compul
conserce erergy. Make a plan actie By selecting
<

Plsns shown on the battery meter
& Balanced Battery i 49
Chiange plan settings Pedosmance aaa

Battery ide: 990999
Pedcemance 88

Note: Sleep is the default power saving state in Windows Vista

Figure 1 - 9 - Power Options

1 -18 Power Options



Features & Components

Chapter 2. Features & Components

Overview

Read this chapter to learn more about the following main features and components
of the computer:

Hard Disk Drive

Optical (CD/DVD) Device
7-in-1 Card Reader
ExpressCard Slot

TouchPad and Buttons/Mouse
Function/Hot Key Indicators
Audio Features

Adding a Printer

. |
Overview 2 - 1



Features & Components

™ Hard Disk Drive

\ A/

’Ll‘ The hard disk drive is used to store your data in the computer. The hard disk can be
Power Safety taken out to accommodate other 2.5" serial (SATA) hard disk drives (see “Storage”
on page C - 2) with a height of 9.5 mm.

Before attempting to ac-

cess any of the internal L .
SO i e The hard disk is accessible from the bottom of your computer as seen below. For fur-

computer please ensure ther details see “Upgrading the Hard Disk Drive” on page 6-4.
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure2-1
Hard Disk Location

. |
2 - 2 Hard Disk Drive



Features & Components

Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de- Z

vice will depend on the module you purchased (see “Storage” on page C - 2). The Sound Volume
optical device is usually labeled “Drive D:” and may be used as a boot device if Adjustment
properly set in the BIOS (see “Boot Menu” on page 5 - 12). How high the sound vol-

ume can be set depends

Loading Discs on the setting of the vol-
ume control within Win-

To insert a CD/DVD, press the open button @ and carefully place a CD/DVD onto | gows. Click the Volume
the disc tray with label-side facing up (use just enough force for the disc to click onto | icon on the taskbar to
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you | check the setting (see
are ready to start. The busy indicator @ will light up while data is being accessed, | Audio Features® on

. L ) . . ; 2-10).
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt- bage )
ed, insert an object such as a straightened paper clip into the emergency eject hole
to open the tray.
©toop Y Figure 2 - 2

Optical Device

Optical (CD/DVD) Device 2 - 3



Features & Components

Handling CDs or DVDs

7\[:1% Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be

CD Emergency Eject
accessed.

If you need to manually

gjecta CD (e.g-due to I\ RGR{el[[e)WWIgls)

an unexpected power

LIEERT RS CIER eV« Hold the CD or DVD by the edges; do not touch the surface of the disc.
EEREERCIE SRS  «  Use a clean, soft, dry cloth to remove dust or fingerprints.
f;{g'g}fi?ﬁgrg‘;‘gejﬂg « Do not write on the surface with a pen.

L SENEE el ¢ Do not attach paper or other materials to the surface of the disc.
GNeRETEEE R ETER ¢ Do not store or place the CD or DVD in high-temperature areas.
SUSCRREIEIREESUIIESE o Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
SRR e . Do not bend the CD or DVD.

db lodged i -
%ne hofe(?ome =S8l . Donot drop or subject the CD or DVD to shock.

Disk Eject Warning

Don't try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.

.|
2 - 4 Optical (CD/DVD) Device



Features & Components

DVD Regional Codes

To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 13.

DVD Regional Coding

Table2-1

Reglon Geographlcal Location I""""”'” . DVD Regiona| Coding
| General | DVD Region | Volumes | Diiver, | Details|
1 USA, Canada N T e B L s
play discs from that region by selecting a geographic area from the
following fist.
2 Western Europe, Japan, South CAUTION You conchenge e regn s ded runber f trcs
Africa, Middle East & Egypt F you renetal idows of move your DVD e o & Gfferert compufr, Fi 2.3
. i Changes remaining: 5 Ig u re X -
South-East Asia, Taiwan, South To changs the current rsgion, sslsct a gsographic ars, and then ik OK DVD Regions
3 Korea, The Philippines, Indonesia, ,
Hong Kong aneg%’adem\ﬁtes -
OrwcdStame
Uruguay
4 South & Central America, Mexico, EQEE';EZ” |
. Watican City -
Australia, New Zealand >
Curert Region: [Not Selected
5 N Korea, Russia, Eastern Europe, Newiegont,  [Fegon 1
India & Most of Africa

6 China

Optical (CD/DVD) Device 2 - 5



Features & Components

4

Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

Figure 2 -4
Right View

1. Card Reader

7-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the Card Reader driver
(see “CardReader” on page 4 - 6).

* MMC (MultiMedia Card) e MS Duo (requires PC adapter*)
» SD (Secure Digital) * Mini SD (requires PC adapter*)
e MS (Memory Stick) * RS MMC (requires PC adapter*)

e MS Pro (Memory Stick Pro)

*Note: The PC adapters are usually supplied with these cards.

. |
2 - 6 7-in-1 Card Reader
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ExpressCard Slot

The computer is equipped with an ExpressCard/34/54 slot that reads Express Card/
34 and ExpressCard/54 formats. ExpressCards are the successors to PCMCIA (PC
Cards). Make sure you install the Card Reader driver (see “CardReader” on page 4
- 6).

ExpressCard/54 is used for applications which require a larger interface slot, e.g.
CompactFlash card reader. The number denotes the card width; 54mm for the Ex-
press Card/54 and 34mm for the ExpressCard/34.

Inserting and Removing ExpressCards

» Align the ExpressCard with the slot and push it in until it locks into place (as
pictured in the generic figure below).

» To remove an ExpressCard, simply press the card to eject it.

4

ExpressCard
Slot Cover

Make sure you keep the
rubber cover provided in
the ExpressCard slot
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the Express-
Card Slot.

Figure 2 -5
Left View

1. Express Card Slot

Figure 2 -6
Inserting &
Removing Express
Cards

ExpressCard Slot 2 - 7
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Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure

your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device's user docu-
mentation for details.

Figure 2 -7

Mouse Properties

TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse.

Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 6) you
can configure the functions by double-clicking the TouchPad driver icon £ on the
taskbar. You may then configure the TouchPad tapping, buttons, scrolling, pointer
motion and sensitivity options to your preferences. You will find further information
at www.synaptics.com.

Mouse Properties

Buttons | Pointers | Pointer Options | Whesl | Hardware | ) Devics Settings |

5

¥ Mouse Properties

[ Buttons | Parers | Painter Options | Whel | Herdware | @) Device Sefings

Button configuration

Synaptics TouchPad V6 3on PS/2Pot3
 Lefthanded

Devices:

@ Right-handed
-

Right
- Sscondary Click (Context
Menu, Special Drag)

Left
- Primary Click (Nomal Select,
Normal Drag)

LS

- Double Click Speed -
Double-click the folder to test your setting. 1 the folder does not

Enables you to highlight or drag without helding down the mouse butten. To set,
briefly press the mouse button. To release. dlick the mouse bution again.

open or close, try using a slower setting,
Slow Fast D
[ ClickLock 1
I™ Tum on ClickLock Stting

Devices:

Synaptics Pointing Device -v3.0.2 120ct06

55|

Enabled | Mame | Port
Yes aptics TouchPad V6 3 PS/2
] Disable ] Settings ]
~Tray leon
" Remove tray icon from taskbar 420FM
" Static tray icon in taskbar M 420PM
& Animated tray icon in taskbar BT 420PM

www synaptics com

—OK Cancel Apply

2 - 8 TouchPad and Buttons/Mouse



Features & Components

Function/Hot Key Indicators

The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn
key is held down. In addition to the basic function key combinations; visual indica-
tors (see the table below) are available when the hot key utility is installed (see “Hot
Key” on page 4 - 6). After installing the driver an icon [ will appear in the taskbar.

*When enabled, Silent Mode will reduce fan noise and save power consumption.

Note this may reduce computer performance.

Function/Hot Key Indicators 2 - 9

Fn Function Fn Function
Keys Keys
_ : S PC
TouchPad — e Fn + Camera ) '
Fn+F1 ) )
" Toggle @ @ F10 Pow?r é @ s ,,“‘& Table2 -2
Toggle e — .
Function/Hot Key
WLAN H
e Mute | 6 n+ Module @ @ Combo Indicators
Toggle ; 4 ; - F11 Power e ® e
Volume On Volume *  Mute Toggle =
Volume Bluetooth
En + Fn + Module . .
Fas | Decieas G Az | poe |
Toggle e
Brightness *Silent
En+ Normal Silent @
Decrease/ M Mode : H
F8/Fo Increase Toggle mde@ )
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Audio Features

You can configure the audio options on your computer from the Sound " control
panel in Windows, or from the Realtek HD Audio Manager g icon in the taskbar/
control panel (right-click the taskbar icon gfjl to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination.

4

Sound Volume
Adjustment

The sound volume level

is set using the volume
control within Windows

F & = 1] Realtek HD Audic Manager =)
(and the volume func- £]I| ‘sound Manager % e s
tion keys on the comput- T ogoe J@J" s lEQ ”"“"'”"*‘ o
- wy Audio Devices =
er). Click the volume e — o
icon in the t_askbar to % S S B e I m
Check the Settlng- - Speaker C | Sound Effects | Default Format .
—_— @ Windows Media Player (]
Speaker Configuration © ®
G =) @ | 2 2
f; Volume Control g
i -“.'——————1-”. Internal
| .j;é Sound Recorder ] ‘ \

Right-click the icon
to access the menu

Full-range Speakers
Front left and right

R

DIGITAL

above. — ®
; &4 REALTEK [
Figure 2 - 8
Realtek Audio
Manager

2 - 10 Audio Features
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Adding a Printer

The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:

1.

arwbd

Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-
tridge etc.).

Turn ON the computer.

Turn ON the printer.

Connect the printer’'s USB cable to one of the USB ports on the computer.
Windows will identify the printer and either load one of its own drivers or ask you
to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.

Adding a Printer 2 - 11

4

Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer's
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.



Power Management

Chapter 3. Power Management P

Overview OS Note

To conserve power, especially when using the battery, your computer power man- | Power  management

P functions will vary slight-
agement conserves power by controlling individual components of the computer ly depending on your

(the monitor and hard disk drive) or the whole system. This chapter covers: operating system. For
more information it is
e The Power Sources best to refer to the user’s

« Turning on the Computer EE @ 7o EREE:

ing system.
« Power Plans a
» Power-Saving States (Note: All pictures used
» Configuring the Power Buttons on the following pages

are from the Windows

 Battery Information :
Vista OS.)

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.

. |
Overview 3 - 1



Power Management

The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

3
. AC/DC Adapter

Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.

2. Plug the AC power cord into an outlet, and then connect the AC power cord to the
AC/DC adapter.

3. Raise the lid/LCD to a comfortable viewing angle.

4. Press the power button to turn “On”.

Battery

The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do | completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.

. |
3 - 2 The Power Sources
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Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the pow- Z
er button on the front panel. Shut Down

Note that you should al-
When the computer is on, you can use the power button as a Sleep/Hibernate hot- | ways shut your comput-
key button when it is pressed for less than 4 seconds (pressing and holding the power | erdown by choosing the
button for longer than this will force the computer to shut down). Use Power Op- | Shut Down command

. . . . . from the Lock Button
tions (Hardware and Sound menu) control panel in Windows Vista to configure | vicnu in Windows Vis-

this feature. ta. This will help prevent
hard disk or system
problems.

/ Connect To Switch User
Log Off

Control Panel Leck
Forced Off

Default Programs Restart

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the pow- Help and Support =i

Hibernate

er button for 4 seconds, or longer, to force the system to turn itself off. - Shurt Down
l-'.-ﬁ’ JETINGE

Power Button Sleep

Search

Sleep is the default power mode when the power button is pressed for less than 4 seconds.
You may configure the options for the power button from the Power Options (Hardware
and Sound menu) control panel in Windows Vista (see your OS’s documentation, or
“Configuring the Power Buttons” on page 3 - 8 for details).

| Windows Vista™

Turning on the Computer 3 - 3
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Power Plans

The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

4

Resuming
Operation

The settings may be adjusted to set the display to turn off after a specified time, and

see Tables - L on § y\cond the computer into Sleep after a period of inactivity.

page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.

e
33 « PowerOptions » Edit Plan Settings v | 42 [l search 2|

Change settings for the plan: My Plan 1

[EeRr=c=)

5 Power Options

Password

Advanced settings ‘

It is recommended that

Select the power plan that you want to customize, and
then choose settings that reflect how you want your

you enable a password
on system resume in or-
der to protect your data.

® Putthe computertoslecp: (15 minutes ~| [2hour - [On battery: [ L
Plugged in: Ves
- (= Hard disk B
Flgure 3-1 ' C change advanced power settings P | = Tumoff hard disk after
On battery: 10 Minutes
Power Plan

Advanced Settings

3 - 4 Power Plans

Choose the sleep and display settings that you want your computer to use.

j On battery

£ Pluggedin

@ Tum off the display: [5 minutes ] [20 minutes

Save changes

@

@ Change seftings that are currently unavailable

computer to manage power.

[My Created PLan [Active] v

= Additional settings
= Require a password on wakeup

Plugged in: 20 Minutes
[ Wireless Adapter Settings
@ Sleen

Restore plan defaults




Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-

ered.

I )5l » Conrotane > Pouer Optos Lo 0]

Require a password on wakeup

Choose what the power

Create a power plan

Choose when to turn off the
display

Change when the computer
sleeps

See also

Personalization

‘Windows Mobility Center

User Accounts

[E=EERES)

@
Select a power plan

Power plans can help you maximize your computer's performance or conserve
energy. Make a plan active by selecting it, or choose a plan and customize it by
changing its power settings. Tell me more about power plans

Plans shown on the battery meter

(7 Balanced Battery life: @20
Change plan settings Performance: @@e

() Power saver Battery life: @00990
Change plan settings Performance: @@

@ High performance Battery life: @@
Change plan settings Performance: #9999

Power Management

Figure 3-2
Power Plans

Power Plans 3 - 5
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Power Button

The Power Button [}
in the Start Menu (in
Classic View use the
Shut Down button |0])
can be used to send the
computer into a power-
saving state.

Sleep Mode &
Mobile PC Battery

A mobile PC in Sleep
uses very little battery
power.

After an extended peri-
od of time the computer
will save any open docu-
ments and applications
to hard disk.

Power-Saving States

You can use power-saving states to stop the computer’s operation and restart where
you left off. Sleep is the default power-saving state in Windows Vista.

Earlier versions of Windows used Stand By and Hibernate as system power-saving
states. Windows Vista combines the features of Stand By and Hibernate into the de-
fault Sleep power-saving state.

Sleep

In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power.

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

3 - 6 Power-Saving States



Hibernate

Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut Down

You should shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from shut down takes longer than
from Sleep or Hibernate.

Log Off
Control Panel Lock
Default Programs Restart
Help and Support Sleep
_ Hibernate
(V)] I E = ’ Shut Down

Power-Saving States 3 - 7

Power Management

4

Silent Mode

You can use Silent
Mode to reduce power
consumption and fan
noise.

Use the Silent Mode
hot key AR to toggle this
mode on/off.

On screen visual indica-
tors and the LED indica-
tor & will display the
Silent Mode status (see
Table 2 - 2, on page 2 -
9, and Table 1 - 3, on
page 1-7).

Note Silent Mode may
reduce computer perfor-
mance.

Figure 3- 3
Lock Button menu
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Configuring the Power Buttons

Z The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the

Password computer in to a power-saving state.
Protection

It is recommended that
you enable a password
on wake up in order to Define power buttons and turn on password protection

protect your data,. Choose the power settings that you want for your computer. The changes you make to the settings on this
page apply to all of your power plans,

@@g@ » Control Panel » Power Options » System Settings

@ Change settings that are currently unavailable

However you can dis-
able this setting from the
Power Options menu
by clicking Require a © whentpressthe power buttor: [sieep = -]

Power and sleep buttons and lid settings

] On battery J Plugged in

password on wakeup X
in the left menu, and se- @ whentprestneseppuon (TS

Shut down

lecting the options (click % When [ clase the lid [Steep -] [slesp -
Change settings that
are currently unavail-
able).

Password protection on wakeup

@ Require a password (recommended)
‘When your computer wakes from sleep, no one can access your data without entering the correct
password to unlock the computer. Create or change your user account password

Don't require a password
‘When your computer wakes from sleep, anyone can access your data because the computer isn't

Figure 3-4 locked.

Power Options
Define Power Save changes
Buttons

.|
3 - 8 Configuring the Power Buttons



Resuming Operation

You can resume operation from power-saving states by pressing the power button,

or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status

Icon o/ Color

To Resume

Power Off Off Press the Power Button
Press the Power Button
Sleep Blinking Green
Press the Sleep Button (Fn + F4 Key Combo)
Off (battery)
Hibernate Press the Power Button

Orange (AC/DC adapter)

Display Turned Off

Green

Press a Key or Move the Mouse/Touchpad

4

Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).

Power Management

4

Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table3-1
Resuming
Operation

Configuring the Power Buttons 3 - 9
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Battery Information

\ A/
’Ll\ Please follow these simple guidelines to get the best use out of your battery.
Low Battery

EITAE, Battery Power

WHERRGESEAEVASEEEE Y our computer’s battery power is dependent upon many factors, including the pro-
B EEEEV A grams you are running, and peripheral devices attached. You can set actions to be
B R taken (e.g. Shut down, Hlbe'rnate etc.), _and set critical and low battery levels from
S e e e power plan Advanced Settings (see Figure 3 - 1 on page 3 - 4).

erwise, the unsaved

CEERULREEREESIEIER  Click the battery icon [B[T in the taskbar to see the current battery level and charge
the power is depleted.

connect the AC/DC

> 5 Power Options [EA==)
- % available {plugged in, chargin Advanced settings
54% lable {plugged in, charging
= Select the power plan that you want to customize, and
\13 then choose settings that reflect how you want your
T T computer to manage power.
P plame @ Change settings that are currentl
) My Planl [MyPlan1 v
Flgure 3 _ 5 @ Power saver - Rattery
= Critical battery action
71 High performance B Lonaticyieve]
Battery Ilcon - &) Critical battery level
= Low battery notification
(Taskbar) & Battery Onbatten: On L
P Learn how to conserve power Fqocdins o8 .
Advanced Settings e 1500 it =
Mare power options 7 be nothing Bl
Windows Mohility Center L Pluacedin Donothing ig
| e ectore plan defauts
— Shut down N - B
A= ]
< Ty = Hal T g5 Am o

3 - 10 Battery Information



Conserving Battery Power

» Use a power plan that conserves power (e.g Power saver), however note that 4
this may have an affect on computer performance.

» Lower the brightness level of the LCD display. The system will decrease LCD
brightness slightly to save power when it is not powered by the AC/DC adapter.

* Reduce the amount of time before the display is turned off.

» Close wireless, Bluetooth, modem or communication applications when they are

not being used.

» Disconnect/remove any unnecessary external devices e.g. USB devices,

ExpressCards etc.

@ Windows Mobility Center

Mute

Yolume

Mo sync
partnerships

"ﬂ 50% remaining

Power saver hd

Battery Status

@@ Not presenting

| Sync settings ‘

‘ Tum on

Sync Center

Presentation Settings

o |
2 No display
il HatcoAnecied connected
| Turn wireless off | | LConnect display ‘
Wireless Network External Display

)

Power Management

Windows Mobility
Center

The Windows Mobility
Center control panel pro-
vides an easy point of ac-
cess for information on
battery status, power plans
used and wireless device
status etc.

Figure 3-6
Windows Mobility
Center

Battery Information 3 - 11
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Battery Life

Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason see “Removing the Battery” on page 6 - 3.

New Battery

Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter

The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to ““- LED Status
Indicators” on page 1 - 7 for information on the battery charge status, and to “Bat-
tery Information” on page 3 - 10 for more information on how to maintain and
properly recharge the battery pack.)

.|
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Proper handling of the Battery Pack

» DO NOT disassemble the battery pack under any circumstances 7\[\1’:
» DO NOT expose the battery to fire or high temperatures, it may explode Callion

* DO NOT connect the metal terminals (+, -) to each other
Danger of explosion if
battery is incorrectly re-

o placed.
2 &

Damaged Battery Warning

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer

down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.

.|
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Battery FAQ

How do | completely discharge the battery?

Use the computer with battery power until it shuts down due to a low battery. Don’t
3 turn off the computer even if a message indicates the battery is critically low, just let

the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.

2. Create a power plan for discharging the battery and set all the options to Never.

3. Click Change plan settings (after saving it) and click Change advanced power
settings.

 Power Optam

Change settings for the plan: Battery Discharge ’

Figure3-7 ) onsem
Power Plan Create © Temotoedopier [nw. .
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4,
5.

Scroll down to Battery and click + to expand the battery options.
Choose the options below (click Yes if a warning appears):

Advanced settings

Select the power plan that you want to customize, and
‘f'; then choose settings that reflect how you want your
computer to manage power.
@? Change settings that are currently unavailable

[Battery Discharge [Active] -

= Battery
= Critical battery action
On battery: Shut down
Plugged in: Do nothing
= Low battery level
Plugged in: 0 % -
= Critical battery level
On battery: 0 %

Pluoned in: 01 %

Restore plan defaults

Power Management

Advanced ssttings

|

Select the power plan that you want to customize, and
‘f; then choose settings that reflect how you want your
computer to manage power.
@] Change settings that are currently unavailable

l Battery Discharge [Active] V]

On battery: 0 %% -
Plugged im: 0 %
&=l Critical battery level
on barer 5 EREES
Plugged in: 0 % )
& Low battery notification
=l Low battery action
On battery: Do nothing
Plugged in: Do nothing

« [

Figure 3-8

i Power Options
Advanced Settings -
| Battery

Restore plan defaults

ok J[ Conedl [ ooy

Low battery levels = 0%
Critical battery Levels = 0%
Low battery action = Do Nothing

il

[ ok [ conca [[ sopl

I |

Critical battery action (On battery) = Shut Down
Critical battery action (Plugged in) = Do Nothing

Battery Information 3 - 15
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes

from orange to green.
How do | maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.

.|
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Drivers & Utilities

Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

What to Install

The Device Drivers & Utilities + User’s Manual CD-
ROM contains the drivers and utilities necessary for
the proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated (see “Driver Installa-
tion” on page D - 25 for Windows XP information).

Module Driver Installation

The procedures for installing drivers for the PC Cam-
era, Wireless LAN, Bluetooth, 3G and Fingerprint
modules are provided in “Modules & Options” on
page 7 - 1.

What to Install 4 - 1




Drivers & Utilities

Driver In Stal | at| on 1. Check the driver installation order from Table 4 - 1,
on page 4 - 3 (the drivers must be installed in
Insert the Device Drivers & Utilities + User’s Manual this order) which is the same as that listed in the
CD-ROM and click Install Drivers (button). Drivers Installer menu below.
2. Click to select the driver you wish to install, after
If you wish to install the drivers manually see overleaf installing each driver it will become grayed out (if
4 for the driver path information. you need to reinstall any driver, click the Unlock
button).

[ B = =& 3 Follow the instructions for each individual driver
installation procedure as listed on the following
pages.

Figure 4 - 1 - Drivers Installer Screen 1

Figure 4 - 2 - Drivers Installer Screen 2

4 - 2 Driver Installation
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Manual Driver Installation

If you wish to install the drivers manually, click the Exit button to quit the Drivers Installer application, and
then browse to the executable file in the location listed in the table below and follow the installation procedure
for each driver. Note that X is the drive letter assigned to the CD/DVD-ROM drive.

Driver Page Driver Location

Video Page 4 -5 Vista 32bit: X:\Drivers\01VGA\setup.exe

Audio Page 4 -5 Vista 32bit: X:\Drivers\02Audio\Setup.exe

Modem Page 4 -5 Vista 32bit: X:\Drivers\03Modem\ssetup.exe

LAN Page 4 -5 Vista 32bit: X:\Drivers\O4Lan\setup.exe

TouchPad Page 4 -6 Vista 32bit: X:\Drivers\05Touchpad\setup.exe

CardReader Page 4 -6 Vista 32bit: X:\Drivers\O6Reader\Setup.exe

Hot Key Page 4 -6 Vista 32bit: X:\Drivers\07Hotkey\Setup.exe

PC Camera odle Page 7-3 | YIS 201 XOters02cameraGztseuyexe (o 00K o L il Camer)
Wireless LAN Module Page 7 - 11 Vista 32bit: X:\Others\O1RTL8187\setup.exe

Bluetooth Module Page 7 - 16 | Vista 32bit: X:\Others\03Bluetooth\setup.exe

3.5G Module Page 7 - 23 Vista 32bit: X:\Others\04_3G\3G.msi

Fingerprint Reader Module Page 7 - 28 Vista 32bit: X:\Others\0O5Fingerprint\Application\x86\autorun.exe

Table 4 - 1 - Driver Installation and Location

. |
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Updating/Reinstalling Individual Drivers

If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall
the driver for (you may need to click “+" to expand
the selection).

4. Click Driver (tab) and click the Update Driver or
Uninstall button and follow the on screen prompts.

User Account Control (Win Vista)

If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message

If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found

If you see the message “New Hardware Found”
(Found New Hardware Wizard) during the installa-
tion procedure (other than when outlined in the
driver install procedure), click Cancel to close the
window, and follow the installation procedure.

4 - 4 Driver Installation



Driver Installation Procedure

Video

1. Click 1.Install VGA Driver > Yes.

2. Click Yes (click Yes if you want to view the
ReadMe file).

3. Click Yes to restart the computer.

Audio

1. Click 2.Install Audio Driver > Yes.
2. Click Next.

3. Click Finish to restart the computer.

Drivers & Utilities

Modem

1. Click 3.Install Modem Driver > Yes.

2. Click OK.

3. The modem is ready for dial-up configuration.

4

Modem Country Selection

Go to the Phone and Modem Options control panel
(Hardware and Sound) and make sure the modem
country selection is appropriate for you.

LAN

1. Click 4.Install LAN Driver > Yes.

2. Click Next.

3. Click Finish > Finish to restart the computer.
4. The network settings can mow be configured.

Driver Installation 4 - 5
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TouchPad

1. Click 5.Install Touchpad Driver > Yes.

2. Click Next.

3. Click Finish > Restart Now to restart the com-
puter.

4. You may then configure your TouchPad as out-
lined in “TouchPad and Buttons/Mouse” on
page 2 - 8.

CardReader

1. Click 6.Install Cardreader Driver > Yes.
2. Click Next > Next.

3. Click Finish to restart the computer.

Hot Key

1. Click 7.Install HOTKEY Driver > Yes.

2. Click Next > Install.

3. Click Finish > Finish to restart the computer.

PC Camera Module

See the introduction in “PC Camera Module” on
page 7 - 2, and check the installation procedure.

Wireless LAN Module

See the introduction in “802.11 b/g USB WLAN Mod-
ule” on page 7 - 11, and check the installation proce-
dure.

Bluetooth Module

See the introduction in “Bluetooth Module” on
page 7 - 16, and check the installation procedure.

3.5G Module

See the introduction in “3.5G Module™ on page 7 - 20,
and check the installation procedure.

Fingerprint Reader Module

See the introduction in “Fingerprint Reader Module”
on page 7 - 28, and check the installation procedure.

4 - 6 Driver Installation
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Chapter 5: BIOS Utilities "

OverVieW BIOS Settings
Warning
This chapter gives a brief introduction to the computer’s built-in software: _
Incorrect settings can
Diagnostics: The POST (Power-On Self Test) Cmaatifsfncil,zunr ng/ it;rgc:o
mistakes, return to Set-
Configuration: The Setup utility up and restore the Set-

If your computer has never been set up, or you are making important changes to the SR ERIERILES GRS

system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.

. |
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The Power-On Self Test (POST)

Z Each time you turn on the computer, the system takes a few seconds to conduct a
POST Screen POST, including a quick test of the on-board RAM (memory).
;'E'ng;rggrma""” As the POST proceeds, the computer will tell you if there is anything wrong. If there

3.Memory status is a problem that prevents the system from booting, it will display a system summary

4.Enter Setup prompt || and prompt you to run Setup.
appears only during . . .
POST If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.
Note: The POST screen
as pictured right is for

guideline purposes onIy. Phoenix TrustedCore(tm) N30

Copyright 1985-2006 Phoenix Technologies Ltd.

The POST screen on All Rights Reserved
your computer may ap- Bios Revision: **¥¥xi&
. . i isi 3 Kkkhkkkkk
pear S||ght|y dlfferent. |f KBC/EC Firmware Revision
you disable the Boot- CPU = 1 Processors Detected, Cores per Processor = 29
time Diagnostic Screen Intel(R) Core(TM)2 CPU 6 T5600 @ 1.83GHz
. ! 323M System RAM Passed
the POST screen will not 2048 KB L2 Cache
appear, System BIOS shadowed
ATAPI CD-ROM: Optiarc DVD RW AD-7530A
Mouse intialized
Figure5-1
POST Screen

Press <F2> to enter SETUPe

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors

These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors

This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

e Press <F1> to resume
e <F2>to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.

.|
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The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage ba-
sic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

5 - 4 The Setup Program



BIOS Utilities

Setup Screens

The following pages contain additional advice on portions of the Setup. 2
) ] ] Setup Menus
Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screento | Thé  Setup  menus
ke ch to Set shown in this section are
make changes 10 Setup. for reference only. Your
computer's menus will
Instructions on how to navigate each screen are in the box along the bottom of the | indicate the configura- S
screen. If these tools are confusing, press F1 to call up a General Help screen, and “O“daf’pr%p“att_e for your
then use the arrow keys to scroll up or down the page. mocet and opfions.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow » next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.

The Setup Program 5 - 5
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. PhoenixBIOS Setup Utility
Figure5-2 I
. Main Advanced Securit Boot Exit
Main Menu ol
Item Specific Help
(- 12:05]
System Date: [04/23/2007]
. <Tab>, <Shift Tab>, or
» IDE Channel 0 Master [Optiarc DVD RW AD-7530A- (] e colcers Floid.
» SATA Port 1 [FUJITSU MHV2100BH PL-(S1)]
System Memory 633 KB
Extended Memory 390144 KB
Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

System Time & Date (Main Menu)

The hour setting uses the 24-hour system (i.e., @@ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

. |
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IDE Channel 0 Master (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of an optical Device
on the computer’s IDE Channel 0. Use the Auto (Type:) setting to have the items
configured automatically for you.

SATA Port 1 (Main Menu)

Pressing Enter opens the sub-menu to show the configuration of a HDD on the com-
puter’s SATA port. Use the Auto (Type:) setting to have the items configured auto-
matically for you.

System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

. |
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Advanced Menu
Figure5-3

PhoenixBIOS Setup Utilit;
Advanced Menu s ¥

Advanced Security Boot Exit

WinXp/vistal Select the operating

Item Specific Help

system installed

on your system which
you will use most
commonly.

IDE PATA+SATA ID Control [5513+1183]

Boot-time Diagnostic Screen: [Enabled]

Note: An incorrect
setting can cause
some operating
systems to display
unexpected behavior.

Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

Installed O/S: (Advanced Menu)
This setting tells the computer what kind of operating system you’re using.

I
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IDE PATA+SATA ID Control (Advanced Menu)
You can configure IDE PATA +SATA device ID control from this menu, if you

have specific requirements to do so.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen. Enable this
item to display the POST screen as illustrated in “POST Screen” on page 5 - 2.

. |
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4

Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also

Security Menu

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit

Supervisor Password Is:

Clear

Item Specific Help

Supervisor Password

IEnter] controls access to the
aCFeSS '.:O your ma- Eocer setup utility.
Chlne as |t bOOtS Up af' Password on boot: [Disabled]

Fixed disk boot sector: [Normal]

ter you turn it on.
These settings do not
affect your machine or

network  passwords
which will be set in
your software OS.
Figure 5 - 4 Help Select Item Change Values Setup Defaults
Exit Select Menu Select P Sub-Menu Save and Exit

Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the PhoenixBIOS Setup Utility. This will not
affect access to the computer OS (only the PhoenixBI10OS Setup Utility).
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Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may ;Zl’;
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the

warning in the sidebar). The default setting is “Disabled”. If you set a boot pass-
word (Password on boot
is “Enabled’), NEVER

forget your password.

Password Warning

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter

again to confirm the password clearance. UL CRMESilEEs of

this could be serious. If
. . . you cannot remember
Fixed disk boot sector: (Security Menu) your boot password you
If you choose “Write-Protect” this will protect against viruses being written to the FulESEeEICc @SS
hard disk boot sector (this is not a substitute for installing an anti-virus program - see [ Sl EEUEALEEEL

o v of the information on
Viruses” on page 8 - 4). your hard disk.

.|
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Boot Menu

Figure 5 _ 5 PhoenixBIOS Setup Utility

Item Specific Help

Boot priority order:

2. USB FDC: Keys used to view or
3: USB HDD: configure devices:
4: USB CD: Optiarc DVD RW AD-7530A- (P Up and Down arrows
5: IDE 4: FUJITSU MHV2100BH PL-(S1) select a device.

6: 1IDE 5: <+> and <-> moves

e PCI BEV: SiS191 UNDI, PXE-2.1

the device up or down.
<x> exclude or include
o the device to boot.
USB 2IP <Shift +1> enables or
USB LS120 disables a device.

<1 - 4> Loads default
boot sequence.

8:
Excluded from boot order:

Help Select Item Change Values Setup Defaults
Exit Select Menu Select PSub-Menu Save and Exit

When you turn the computer on it will look for an operating system (e.g. Windows
Vista) from the devices listed in this menu, and in this priority order. If it cannot
find the operating system on that device, it will try to load it from the next device in
the order specified in the Boot priority order. Item specific help on the right is
available to help you move devices up and down the order.
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Exit Menu

PhoenixBIOS Setup Utility Figure5-6

E—L———EEE. - Exit Menu

Item Specific Help

Exit Discarding Changes Exit System Setup and
Load Setup Defaults save your changes to
Discard Changes CMOS .

Save Changes

Help Select Item Change Values Setup Defaults
Exit Select Menu Execute Command Save and Exit

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

. |
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Chapter 6: Upgrading The Computer

Overview

| ins informai | L
This chapter contains information on upgrading the computer. Follow the steps out- —
lined to make the desired upgrades. If you have any trouble or problems you can con- Warranty Warning

tact your service representative for further help. Before you begin you will need: Please check with your

« A small crosshead or Phillips screwdriver service  representative

. before undertaking an
» Asmall regular slotted (flathead) screwdriver upgrade procedurges tz)/

* An antistatic wrist strap find out if this will VOID
your warranty.

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

* Removing the Battery

» Upgrading the Hard Disk Drive

» Upgrading the Optical (CD/DVD) Device
» Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.

. |
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When Not to Upgrade

\ A/

7£l< These procedures involve opening the system’s case, adding and sometimes replac-

Power Safety ing parts.
Warning

You should not perform any of these upgrades if:
Before you undertake

any upgrade proce- . ] ]

S e B ¢ Your system is still under warranty or a service contract
VEIEVER TG REETERl o You don’t have all the necessary equipment
SONEISEUCREIERCIEEE] o You're not in the correct environment

S BREIEEEREUERE . You doubt your abilities
cables (including tele-

phone lines). It is advis- . ) ]
able to also remove your Under any of these conditions, contact your service representative to purchase or re-
battery in order to pre- place the component(s).

vent accidentally turning
the machine on.

AN
I

Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.

. |
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Removing the Battery ™

If you are confident in undertaking upgrade procedures yourself, for safety reasons ’Ll\ _

it is best to remove the battery. Warranty Warning
Turn the computer off, and turn it over. Please check with your
Slide the latch @ in the direction of the arrow. service representative

Slide the latch @ in the direction of the arrow, and hold it in place. before undertaking any

Slide the battery out in the direction of the arrow @. gpgradte.f%qced'“n\a/sb ItICD)
Ind out | IS WI

your warranty.

PwnE

Figure6-1
Battery Removal
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o Upgrading the Hard Disk Drive

\ A/
’ﬁl\ The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
HDD System disk drives with a height of 9.5mm (h) (see “Storage” on page C - 2). Follow your
SUELUIRE operating system’s installation instructions, and install all necessary drivers and util-

N Rl el ties (See “Driver Installation” on page 4 - 2), when setting up a new hard disk.
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.

You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.

If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.

Turn off the computer, and turn it over and remove the battery.
Locate the hard disk bay cover and remove screws @ & @.
Remove the hard disk bay cover @.

Grip the tab and slide the hard disk in the direction of arrow @.

PwobhE

Figure 6 - 2
Hard Disk Bay &
Screws
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5. Lift the hard disk up in the direction of arrow @.
6. Remove the screws @ & @ and cover @.
7. Reverse the process to install a new hard disk drive.

Figure 6 - 3
HDD & Cover
Removal

Upgrading the Hard Disk Drive 6 - 5
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Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.

2. Locate the RAM & CPU bay cover and remove screws @ - @.

3. Remove the screw at point 9 and use a screwdriver to carefully push out the
optical device at point @.

4. Reverse the process to install the new device.

Figure 6 - 4
Removing the CD/
DVD Device

6 - 6 Upgrading the Optical (CD/DVD) Device
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Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-
DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for
details of supported module types).

The total memory size is automatically detected by the POST routine once you turn
on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the RAM & CPU bay cover and remove screws @ - @.

Figure6-5
RAM & CPU
Bay Screws

Upgrading the System Memory (RAM) 6 - 7
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3. Carefully (a fan and cable are attached to the under side of the cover) lift up the
bay cover.
Figure 6 - 6 4.

Carefully disconnect the fan cable @), and remove the cover@.

CPU/RAM Bay
Cover Removed

SN
A&

Contact Warning

Be careful not to touch

the metal pins on the . .
module’s  connecting 5.  Gently pull the two release latches on the sides of the memory socket in the

edge. Even the cleanest direction indicated by the arrows (@ & @) in Figure 6 - 7.
hands have oils which
can attract particles, and
degrade the module’s
performance.

Figure 6 -7
RAM Module
Release Latches
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6. The RAM module will @€ pop-up, and you can remove it.

Figure 6 - 8
RAM Module
Removal
&

Fan Cable
Reconnection

7. Pull the latches to release the second module if necessary.

8. Insert a new module holding it at about a 30° angle and fit the connectors firmly
into the memory slot.

9. The module’s pin alignment will allow it to only fit one way. Make sure the module
is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into
place to secure the module.

11. Replace the bay cover and screws (make sure you reconnect the fan cable
before screwing down the bay cover).

12. Restart the computer to allow the BIOS to register the new memory configuration
as it starts up.

Upgrading the System Memory (RAM) 6 - 9
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o Upgrading the Processor

\ A/
’ﬁl‘ If you want to upgrade your computer by replacing the existing processor with a fast-
Warranty er/new one you will need to contact your customer service representative. We rec-
et oo ) ommend that you do not do this yourself, since if it is done incorrectly you may

SO E e el damage the processor or mainboard.
ing this compartment, or
accessing the CPU in

any way, may violate
your warranty.

Unauthorized tampering
with the HDD may also
violate your warranty.

.|
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Chapter 7. Modules & Options "

; Wireless Device
OVGfVleW Operation Aboard
This chapter contains information on the following modules, which may come with Aircraft
your computer, dgpendlng on th_e configuration purchased. If you are unsure please The use of any portable
contact your service representative. electronic transmission

devices aboard aircraft
e PC Camera Module is usually prohibited.

- 802.11 b/g USB WLAN Module e Slis i ket
« Bluetooth Module ulg(s) are OFF if you are
using the computer

* 3.5G Module aboard aircraft.
» Fingerprint Reader Module

\ A/
Z &
Important Notice

If your purchase option includes both Wireless LAN and 3.5G modules, then the appropri-
ate antennas will be installed. Note that In order to comply with FCC RF exposure compli-

ance requirements, the antenna must not be co-located or operate in conjunction with any
other antenna or transmitter.
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™ PC Camera Module
2§

Latest PC Camera

Driver Information

There are 3 camera options available for this computer, depending on your purchase
configuration. The 300K and 1.3M pixel camera modules use the BisonCap appli-
cation to capture video files, and the 2.0M pixel camera module uses the Video

Check the CD, and any View application to capture video files.
accompanying insert

GEESR R Before installing the PC Camera driver, make sure that the optional PC Camera is
dated information on the

PC  Camera  driver on. Use the Fn + F10 key combination (see Table 1 - 5, on page 1 - 10) to toggle
which may override the power to the PC Camera module. Make sure you install the drivers in the order

information  provided indicated in Table 4 - 1, on page 4 - 3.
here.
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PC Camera Driver Installation

1.

2.
3.

Make sure the module is powered on, and then insert the Device Drivers &
Utilities + User’s Manual CD-ROM into the CD/DVD drive.

Click Optional (button).

Click 1.PC Camera Driver, Web cam > Yes.

For the 1.3M or 300K Pixel Camera Module:

1.
2.
3.

Choose the language you prefer and click Next > Next.

Click Finish to restart the computer.

Run the BisonCap application program from the BisonCam shortcut on the
desktop, or from the BisonCam item in the Start > Programs/All Pro-
grams menu (if the hardware is turned off use the Fn + F10 key combina-
tion to turn it on again).

For the 2.0M Pixel Camera Module:

AR

Click Install.

Click to select Yes or No in answer to the power system question.

Click to select Yes or No to enable/disable the Digital Zoom function.
Click Finish > Finish to restart the computer.

Run the Video View application program from the Video View shortcut on
the desktop, or from the USB2.0 PC Camera item in the Start > Pro-
grams/All Programs menu (if the hardware is turned off use the Fn + F10
key combination to turn it on again).

Modules & Options

. |
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PC Camera Audio Setup (all camera modules)
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1.

w

o

~

10.

Click Start, and click Control Panel (or point to Settings and click Control
Panel).

Click Sound -~ (Hardware and Sound).

Click Recording (tab).

Right-click Microphone (Realtek High Definition Audio) and make sure the item is
not disabled.

Double-click Microphone (or select Properties from the right-click menu).

Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to
the level required.

Click OK and close the control panels.

Run the BisonCap application program from the Start > Programs/All Programs
> BisonCam menu.

Go to the Devices menu heading and select Microphone (Realtek....) (it should
have a tick alongside it).

Go to the Capture menu heading and select Capture Audio (it should have a tick
alongside it).
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[) Playback | Recording ,m‘ ’q JeropbensReeperbes i @ Figure 7 = 1
-Gener Levels | Enhancements | Advane .
" e Audio Setup for PC

'< Micro

b phone Mi h

N Realtek High Definition Audio 2 Cam era
Waorking | O 1o Balance

Configure Speech Recognition...
Disable |

Select a recording device below to modify its settings:

Microphone Boost
Show Disabled Devices 7 i e

v Show Disconnected Devices

Properti

Right-click

rDevica Options  Capture  Help [ Capture | Help [Capture | Help

¥ BisonCarn, MB Pro Start Capture Start Capture
Stop Capture Stop Capture
¥ Micrephone (Realtek High Defini
SnapShot v Capture Audio
[ Devices | Options Capture Help ¥ Capture Audio Set Time Limit...
v USB2.0 2M WebCam Closed Captioning
. . = Master Stream 3
v Microphone (Realtek High Defini ot Frarie Hate.

Set Time Limit...
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4

Pre-Allocating File
Space

You may pre-allocate
the file size for the cap-
ture file in the BisonCap
program. You can
choose to ignore this by
clicking Cancel.

Pre-allocating space on
the hard disk can im-
prove the capture quali-
ty (particularly of large
capture files), by reduc-
ing the amount of work
the hard disk has to do
in finding space for the
video data as it is being
captured.

BisonCap (for 1.3M or 300K pixel camera modules)
BisonCap is a video viewer useful for general purpose video viewing and testing,
and can capture video files to .avi format.

1.

»

Run the BisonCap program from the Start > Programs/All Programs > Bison-
Cam menu (it is recommended that you set the capture file before the capture
process - see Set Capture File below).

Go to the Capture menu heading (if you wish to capture audio check “PC Camera
Audio Setup (all camera modules)” on page 7 - 4) and select Start Capture.
On the first run of the program (if you have not set the captured file) you will be
asked to choose a file name and size (see the sidebar - Pre-Allocating File
Space) for the captured file. Click Start Capture again.

Click OK to start capturing the video, and press Esc to stop the capture.

If you wish to, you may go to the File menu and select Save Captured Video
As..., choose a file name and location, and then click Open (you can view the file
using the Windows Media Player).

Set Capture File

In the BisonCap program you will only be asked to set the capture file name on the
first run of the program. When you run the program the next time the file will auto-
matically be overwritten with the newly captured file. To avoid overwriting files you
can go to the Set Capture File.. option in the File menu, and set the file name and
location before capture. Set the name and location then click Open (you can choose
Cancel to ignore the file size if prompted).
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Eliminating Screen Flicker (BisonCap)
If you find that the video screen in the BisonCap program is flickering, you can try
to adjust the setting in the Video Capture Filter options.

1. Runthe BisonCap program.
2. Goto Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

— -
Properties B o
Property Page ] Video Proc Amp ] Camera Control ]
[V duto White Balance [~ RGB gamn— i Flgure 7-2
& i T 5 4] b Video Capture Filter
7 Daylight " Fhoorescent b 7
Rotation - Frequency - \
|| [ Horizntal ™ WVertical " Dnsable (7 B0Hz @ GOHz )
[~ EFFECTMODE : g
-EFFELCT- o
& MOLAIC B
(ol " HEGATIVE
" EMBOSS Beset
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